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Introduction

Welcome and thank you for choosing a TOSHIBA product.

For your convenience, your TOSHIBA product is furnished with two
guides:

a) a Quick Start Guide, and

b) a comprehensive PDF User’s Manual on the included CD.



Section 1

Section 2

Section 3

Contents

Getting to Know Your Camcorder..........ccccommemmninirnnennnnnnnns 3
OVEIVIEW.......ciiiiiiiiiirrrrrecessssssss s s s s e e s s s s s s nnmn s ssssssnn s s e s nnnnnnns 3
Check the Components .........ccooeciiiieeiiiricn e e 3
Safety Instructions ... 4
System Requirements...........ccccviiimmmmmriemeeenccsssnns e eeeeenennes 4
Front View ... s s s 5
Rear VIEW ... 5
Side VIeW.... i 6
Bottom VieW.......ooociiiirreciiiirrrecss s 6
Getting Started..........ooeeiii e ————— 7
Loading the Battery.........c.oormeeiiie e 7
Inserting and Removing an SD Card (Optional) ............... 7
Turning the Camcorder On and Getting Started............... 8
Turning the Camcorder Off ... 8
Record Mode..........ccoiiimimmmmee s 9
Button Function.........cccciiiriciirrrec s 9
LCD Monitor Information ............ccceeiiiiiiiiimnnir, 10
Movie Recording.......ccceeeemeeiiiiiiiiiiinrrnreeesssss s 11
Picture Recording........ccoeeeciiiiimieciiiirrecs e 12
Taking Close up Pictures......cccccccovmmmreeciiiirnssescssseeeeeansnans 12
LW L3 13 T 740 T ] o 1 12
Options for Record Menu ...........cooomiieeecciiirrececcceeeeecenan, 13
Operations for Record Mode .........ccccccceiiiimrreecciiinnneennnnn, 13
Movie Mode Submenu Setting .........ccceeeiiiiiiiicciiiinneeees 14
Picture Mode Submenu Setting .........cccccccceiiirieecciiinneee, 15
Effect Submenu Setting ..., 16

EN



Contents

Section 4 Playback Mode..........cccommmmmmeiiiiiiiirrr 19
Button Function............ooo e 19
LCD Monitor Information ..........cccciiiimiicciirreccceeeeee, 20
Operations for Playback Mode .........cccccooiimmimciiiiinncennnn. 21
Movie PlaybackK..........couoiimiciirecceireecr s e e 21
Movie Playback Mode Menu............ccmieeciiiimineeccinicnnnens 22
Picture Playback..........ccoeeciiiiimiccirrrecis e 24
Picture Playback Mode Menu..........cceeciimmeciimrcecnineennnns 25
Section 5 Setting Your Camcorder .........ccccceciiiiiiieeciininseeennsseeeeeeans 27
Setting Menu........oo e e e e 27
Section 6 Viewing Pictures and Moviesona TV .....cccccccoviiiieencceenns 31
Connecting to a High-Definition 16:9 (Wide) TV............. 31
Connecting to a non-high-definition 4:3 TV.................... 31
Section 7 Viewing Pictures and Movieson PC..........ccccccoirrmnineee. 32
Installing Bundled Software.......c....ccovveeecciiiiiieccinieneeees 32
Transferring Data to a Computer .........cccvveeceiiiiirecennnnn. 32
Section 8 Burning the Recorded Clip into DVD.......ccccccooimmiemnccininnns 33
Section 9 Uploading Video Files to YouTube.......ccccoorrmmirirnninneee. 35
Section 10 Specifications ... 39
Section 11 Troubleshooting .........cceeeeeccciiiiiii s 40
Section 12 Other Information ..., 41
TOSHIBA SUPPOTrt.....coeeerrecccr e e 41
Operating Environment Conditions.......ccc.cccccceevvviirinnnnnns 41
Regulatory Information...........ccoeeiiiiimicciirrecce e, 41
Additional Information............ccorrimr, 43

EN



Section 1
Getting to Know Your Camcorder

Overview

The Camcorder with 5 Mega Pixel sensor and 5X Optical Zoom Lens can take H.264 movies. By way
of using H.264 technology, more videos can be taken within certain amount of memory. High quality
images with up to 8 mega-pixels can also be delivered smoothly. With a color LCD monitor, users can
compose images and examine them easily.

The Camcorder also features movie recording at HD resolution of 1080p. You can also connect it to an
HDTV via HDMI cable, and easily playback recorded high-definition videos on the wide screen HDTV.

Exposure and color balance can either be adjusted automatically or allowed to be changed manually.
An 2x/4x zoom increases user control over the movies and pictures you take.

Built-in memory allows you to take pictures and movies without memory card. The memory card slot
allows users to increase the storage capacity.

' Note
o

Partial memory of the built-in memory is used for Firmware code.

Check the Components

Unpack the package and make sure all standard accessories listed are included:

b=
1] ',ZU
o
7=, @, o
Z— . Lithium-ion
Camcorder USB Cable AV Cable HDMI Cable AC-Adaptor Rechargeable
Battery
M oo ﬁ / g D
Quick Start Guide (Software Cleaning Cloth Strap Pouch i Warranty Leaflet
User’s Manual) Tripod
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Safety Instructions

10.
11.
12.

Do not drop, puncture or disassemble the camcorder; otherwise the warranty will be voided.
Avoid all contact with water, and dry hands before using.

Do not expose the camcorder to high temperature or leave it in direct sunlight. Doing so may
damage the camcorder.

Use the camcorder with care. Avoid pressing hard on the camcorder body.
For your own safety, avoid using the camcorder when there is a storm or lightning.

Do not use batteries of different specifications. Doing so may lead to the potential for serious
damage.

Remove the battery during long periods between usage, as a deteriorated battery may affect the
functionality of the camcorder.

Remove the battery if it shows signs of leaking or distortion.
Use only the accessories supplied by the manufacturer.
Keep the camcorder out of the reach of infants.

Risk of explosion if battery is replaced by an incorrect type.

Dispose of used batteries according to the instructions.

System Requirements

Microsoft Windows 2000/XP/Vista
Intel Pentium [l 800MHz or above
256 MB RAM

CD-ROM Drive

700 MB free HDD space
Available USB port

16-bit Color Display

'+ Note

The LCD screen is manufactured using extremely high-precision technology. However, some
tiny black and/or bright dots (white, red, blue or green) may appear on the LCD screen. These
dots are a normal result of the manufacturing process, and do not affect the recording.
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Side View
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Section 2
Getting Started

Loading the Battery

Before using the camcorder, users must load Lithium-ion rechargeable battery

1. Insert the battery following to the correct polarity marks
(+or-).

2. Close the battery cover firmly.

Inserting and Removing an SD Card (Optional)

The camcorder comes with internal memory which allows you to store pictures and movies. You can
expand the memory capacity by using an optional SD memory card.

1. Insert the memory card into the right position. Please
refer to the figure.

2. To remove an installed SD card, press the card inwards
to release it.

3. When the card pops out, gently remove it from its slot.

4. Recommended memory capacity: 1GB or above.

Note
* When a memory card is fitted, movies/pictures are saved on card rather than on the built-in
memory.

* Protecting Data on an SD Card: SD card is read-only by locking the SD card. No pictures and
movies can be recorded when the SD card is locked. Make sure the lock is on writeable
position before recording any media.

LOCK ‘ LOCK

Writeable Write-Protected
position Position
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Turning the Camcorder On and Getting Started

» To turn on the Camcorder: Flip out the LCD panel or press Power Button for one second. When the

Camcorder is turned on, the green LED will light up.
A
+ To take a movie, press the Movie Shutter Button ( [[5) ).

+ To take a picture: Press the Picture Shutter Button ( (0] ) halfway down till the focusing frame turns
from white to green. Then, press the Picture Shutter Button fully down to take picture.

T ¢ @030 WE @ an

Focusing Frame: White

Focusing Frame: Green

» To view stored movies, pictures, press Record/Play Button (
Press a second time to return to Record Mode.

Turning the Camcorder Off

= ) once to switch to Playback Mode.

» To turn off the Camcorder, you can either press the Power Button for one second, or you can place

the LCD panel back to its original position.
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Section 3
Record Mode

Button Function

Direction Button

)

= Right Button: HD(1080p) / VGA mode switch
~— Left Button: Light ON / OFF

=

Menu/OK Button: Menu On / Validate the setting

Tele (Up) Button: Zoom In

Wide (Down) Button: Zoom out

Power Button: Press down for one second to turn on or turn
off the Camcorder

RECORD/PLAY Button functions:
1. Switch between Record /Playback Mode
=) 2. Return to the previous page

3. For quick review, press it after recording

Movie Shutter Button:

D .
D@ 1. Start to take movie.

2. To stop recording, press it again.

Picture Shutter Button: Start to take picture.




LCD Monitor Information

The indicators shown below may display on LCD when movies and pictures are recorded:

@
®
Movie Resolution
HD (1080p) (30fps)
HD (720p) (30fps)
ok ks WVGA (60fps)
VGA (30fps)
(1)
"ok - QVGA (30fps)
Picture Resolution
[rCn| High
@ Standard
@ Low
71 Number of images that can still be taken at current resolution
(2)
14:26:08 Recording time of movie that can still be taken at current resolution
(3) Y Light On
(4) Q) Self-timer enabled
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Scene

'S Skin

(5)

Night

Backlight

(6)

Macro Position Focusing

Exposure compensation value

(7)

Manual White Balance

(8)

(9) SD Card inserted

Battery: full power

Battery: medium power

5= |[E|8|&=Fx e

(10)

Battery: low power

Battery: power empty

Zoom meter:
(11) HD(1080p): 1X~10X (5X Optical + 2X Digital)

Other video resolution: 1X~20X (5X Optical + 4X Digital)
(12) Stabilization

, Note

Scene: B/W / Classic / Nagative effect can be previewed immediately without indicator on the LCD.

Movie Recording

A
+ Press Movie Shutter button ( ] ) to start recording. When a movie is recording, a time indicator
A

will display on LCD monitor. To stop recording, press Movie Shutter Button (] ) again.
* Press RECORD/PLAY Button to view the recorded movie.

* Five resolution settings are available:

Video Quality

HD (1080p) (30fps)

HD (720p) (30fps)

WVGA (60fps)

VGA (30fps)

QVGA (30fps)

2|18 5|2

1
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Picture Recording

» Press the Picture Shutter Button ( (o] ) halfway down till the focusing frame turns from white to
green. Then, press the Picture Shutter Button fully down to take picture.

* Press RECORD/PLAY Button to view the picture.

* Three resolution settings are available:

Image Quality

High Quality: 8 Mega Pixels

Standard Quality: 5 Mega Pixels

B B |E

Low Quality: 3 Mega Pixels

Taking Close up Pictures

The Camcorder has one close-up picture mode to allow you to take pictures at close range. The
Macro Mode ( 3 ) should be used for objects located within 80 cm.

To take close-up pictures:

Operation Display Screen
1. In Effect Mode Submenu, press Up/Down Button
to select Macro. ” A g B
2. Use Right/Left Buttons to choose Macro or Light off
Normal. Macro Mode Normal <>
3. Press Menu/OK Button to validate the setting. Scene Skin

Exposure +0.3EV
EE OK =3 Exit

Using Zoom

» The zoom magnifies images, when recording movies or taking pictures.
1. To zoom in/out, press the Tele/Wide Button.
2. The zoom can be set as 1X~10X (5X Optical + 2X Digital) / 1X~20X (5X Optical + 4X Digital).

12
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Options for Record Menu

Movie Mode

Picture Mode

Effect

« Resolution

« Stabilization

¢ Resolution

e Self-timer

« Light

* Macro

» Scene

» Exposure

« White Balance

Operations for Record Mode

Operation

Screen

1. Press Menu/OK Button when in Record Mode.

000610 =

@ 4 +0.3EUSweE an

2. Use Right/Left Buttons to move between main menu
options, which are Movie Mode, Picture Mode, Effect,

and Setting.

3. Press Down Button to enter the folder of main option

you select.

4. Press Right/Left button to select the setting options,
then press Menu/OK button to validate.

5. Press RECORD/PLAY button to exit.

. & ©
Resolution VGA
Stabilization ON

3 OK =3 Exit
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Movie Mode Submenu Setting

Operation

Display Screen

1. In Record Mode, press Menu/OK Button to enter
record menu screen.

2. Use Right/Left Buttons to select Movie Mode.

3. The Movie Mode Submenu contains 2 options.
Resolution and Stabilization, for you to adjust the
camcorder setting.

%A & &
Resolution VGA

Stabilization ON

30K =3 Exit

Movie Resolution

Operation

Display Screen

1. In Movie Mode Submenu, press Down button to
enter Resolution.

2. Use Right/Left Buttons to move between five
settings.

3. Press Menu/OK Button to validate the setting.

» n <« @

Y

Resolution VGA o

Stabilization . ON

30K =3 Exit

Stabilization

Operation

Display Screen

1. In Movie Mode Submenu, press Down button to
enter Stabilization.

2. Use Right/Left Buttons to choose On or Off.
3. Press Menu/OK Button to validate the setting.

2 o & @
Resolution VGA

Stabilization ONa

30K =3 Exit

e Note

Stabilization doesn’t support HD(1080p) and WVGA/60fps.
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Picture Mode Submenu Setting

Operation Display Screen

1. In Record Mode, press Menu/OK Button to enter
record menu screen.

2. Use Right/Left Buttons to select Picture Mode.

3. The Movie Mode Submenu contains 2 options,
Resolution, and Self-timer, for you to adjust the
camcorder setting.

=3 QK =3 Exit

Picture Resolution

Operation Display Screen

1. In Picture Mode Submenu, press Down button to
enter Resolution.

2. Use Right/Left Buttons to move between three
settings.

3. Press Menu/OK Button to validate the setting.

3 OK =3 Exit

Self-timer (Picture Record Mode Only)

The self-timer allows you to take pictures with a ten-second self-timer. The Light on the front of the
camcorder will also blink. The speed of blinking will increase just before the picture is taken.

Operation Display Screen

1. In Picture Mode Submenu, press Up/Down

Button to select Self-timer. - o '3" 'f,?}
2. Use Right/Left Buttons to choose On or Off. Resoluti = Low

3. Press Menu/OK Button to validate the setting.

i OK =3 Exit

15
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Effect Submenu Setting

Operation

Display Screen

1. In Record Mode, press Menu/OK Button to enter
record menu screen.

2. Use Right/Left Buttons to select Effect.

3. The Effect Submenu contains 5 options, Light,
Macro, Scene, Exposure, and WB, for you to
adjust the camcorder setting.

|E ﬂ 4 q‘l‘- * {é}
(B [

Magra Mode™ ™" “Normal

Stere Skin

Exposure +0.3EV
B OK =3 Exit

Light

To enable the light by either hot key (Left Button) or select from the effect menu.

*+ On (9 ): The light will be turned on and keeps providing light in the low light environment

» Off: The light is turned off

Operation

Display Screen

1. In Effect Mode Submenu, press Up/Down Button
to select Light.

2. Use Right/Left Buttons to choose On or Off.
3. Press OK Button to validate the setting.

» ol & #

ght Off «»
Magro Mode._. Normal
Scene Skin
Exposure +0.3 EV

I OK =3 Exit

3, Note

The light will be disabled automatically when battery power is low ( ).

Macro

The Camcorder has one close-up picture mode to allow you to take pictures at close range. The

Macro Mode ( Q ) should be used for objects located within 80 cm.

Operation

Display Screen

1. In Effect Mode Submenu, press Up/Down Button
to select Macro.

2. Use Right/Left Buttons to choose Macro or
Normal.

3. Press Menu/OK Button to validate the setting.

”® ol g ©
Light - off

Macro Mode Mormal <»

Scene Skin
Exposure +0.3EV
B QK =3 Exit

16
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Scene

You can select the mode according to the scene condition.

Auto: Shoot without any special effect on the image.

Skin: Shoot with an effect that makea skin tones more natural

Night: Use Night mode for night scenes or low light conditions.
Backlight: You can take shots when bright light is behind the subject.
B/W: The image is converted to black-and-white.

Classic: The image is converted to sepia look.

Negative: The image is converted as the negative of the normal.

Operation Display Screen

1. In Effect Submenu, press Down button to enter

Scene. ” A g o
2. Use. Right/Left Buttons to move between 7 Light Off
settings. Magro Made_. Normal

3. Press OK Button to validate the setting.

Exposure +0.3 EV
3 OK =3 Exit

5 Note

To avoid blurry pictures, place the Camcorder on a flat, steady surface, or use a tripod when
take shots in Night mode.

Exposure

The camcorder adjusts image exposure automatically. In certain circumstances you may wish to adjust

the exposure compensation setting.

Operation Display Screen

1. In Effect Submenu, press Down button to select

Exposure. K ; o | ﬂ* .ﬁ,}
2. Use Right/Left Buttons to choose preferred Light ™ __ . Off

EV(Exposure Value). The change can be Macro Mode Normal

previewed immediately. SEarie Skin
3. Press OK Button to validate the setting. Exposure +0.3EV «

EEOK == Exit

17
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WB (White Balance)

The camcorder adjusts the color balance of images automatically. Three manual white balance
settings are available:

» Auto: The camcorder automatically adjusts white balance.
* Daylight: Under outdoors.
* Fluorescent: Under fluorescent light condition.

* Tungsten: Under tungsten light condition.

Operation Display Screen

1. In Effect Submenu, press Down button to select

WB. o A g B

2. Use Right/Left Buttons to move between %

four settings. The change can be previewed S
immediately. ¥

3. Press OK Button to validate the setting.

30K == Exit

18
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Button Function

Section 4

Playback Mode

The Buttons have the following functions in Movie and Picture Playback Modes.

()
|
()
=

Direction Button
Right Button: Go to the next movie/picture. Fast forward

Left Button: Go to the previous movie/picture. Fast rewind

Menu/OK Button: Enter to movie or picture option menu /
Validate setting.

Tele (Up) Button: Zoom in / Volume increase

Wide (Down) Button: Zoom out / Volume decrease

RECORD/PLAY Button functions:
1. Switch between Record and Playback modes.

2. Return to the previous page.

Movie Shutter Button:

Start playing the recorded movie.

19
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LCD Monitor Information

Indicators on the LCD screen while in Playback Mode:

=1 ot
& @im | —©

AU0I0ONO0008R0000)

(1)

HD (1080p) (30fps)

HD (720p) (30fps)

"ok ks WVGA (60fps)
VGA (30fps)
ook QVGA (30fps)

(Fon ] High

| Standard

x] Low

(2) 00:06:10 Movie playback time counter
(3) 6 Indicate the selected movie/picture is locked.
(4) 0005/0005 Current Number/ Total number of movie or picture.

()

\/[B00ERE0000000000

Volume

(6)

@
5

Indicate the screen is in movie playback mode:Play/Pause

(7)

O

Magnification Indicator.

20
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Operations for Playback Mode

The Playback Mode is for viewing and managing movies and pictures on the built-in memory or on an

SD card.

Operation

Display Screen

1. Press RECORD/PLAY Button ( ) to switch
from Record Mode to Playback Mode Main
Menu. There are 2 options in the Playback
Mode, Movie and Picture.

2. Press Direction Button to select the specific
option.

PICTURE

3. Press Menu/OK Button to enter Movie/ Picture
thumbnail preview folder.

4. Use direction buttons to locate the movies/
picture you want to view.

5. Press Menu/OK button to view the movies/
picture.

MOVIE 0002/0002

Movie Playback

Operation

Display Screen

1. In movie thumbnail preview folder, use direction
buttons to locate the movies you want to view.

2. Press Menu/OK button to play the movies.

MOVIE 0002/0002

3. While playing movie, press Right/Left Buttons to
fast forward/rewind, then release the button to
stop.

4. Use Up/Down Buttons to adjust volume.

00050005 W@ s-'-'.i;:'- :

21
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Movie Playback Mode Menu

Operation Display Screen

1. In Movie Playback Mode, press Menu/OK Button
to enter Movie Playback menu screen. !
]

2. Use Up/Down Buttons to select four options,
Delete, Lock, Repeat One, and Repeat All.

Deleta

Logk
Repeat One
Repeat All
E3OK =3 Exit

Delete Movies

Operation Display Screen

1. Use Up/Down Buttons to select the Delete
option.

Repeat One
Repeat All
L8 OK =3 Exit

2. Press Menu/OK Button to go to the Delete menu.

3. Use Right/Left Buttons to select the movie.

4. Use Up Button to delete all movies or Down -
Button to delete single movie. Or Press
RECORD/PLAY Button to exit.

5. Before a movie is deleted, a confirmation screen
will appear; choosing “Yes” will execute the

operation and “No” will cancel the operation.

6. Press Menu/OK Button to validate the setting.

Delete All

Yes Nao

= One = Exi

') Note
» If a memory card is inserted, you can delete only those movies stored on the card.
* Movies on a written-protected memory card cannot be deleted.

» The delete function will only erase unlocked movies. Locked movies must be unlocked before
being deleted.

22




Lock Movies

Single or all movies can be locked. This function can prevent the movies from being deleted

accidentally.

Operation

Display Screen

1. Use Up/Down Buttons to select the Lock option.

2. Press Menu/OK Button to go to the Lock menu.

A |

Delete

Repeat Cne
Repeat All
3 0K == Exit

3. Use Right/Left Buttons to select the movie.

4. Use Up Button to lock/unlock all movies or Down
Button to lock/unlock single movie.

5. Press RECORD/PLAY Button to exit.

Repeat Movies

This function automatically repeats playing single movie or all movies in order.

Operation

Display Screen

1. Use Up/Down Buttons to select the Repeat One
option or Repeat All option.

2. Press Menu/OK Button to start repeating, press it
again to stop and return to the previous page.

8|

Delete
Logk

Repeaat All

A OK =3 Exit

8§

Delete
Lock
Repeat One

A OK =3 Exit

23
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Picture Playback

Operation

Display Screen

1. In Picture thumbnail preview folder, use direction
buttons to locate the picture you want to view.

2. Press Menu/OK button to view the picture.

PICTURE 0005/0005

o

T e T
e =
p

LY

Ay

9

3. Use Right/Left Buttons to go to the next or last
picture.

4. While the picture is selected, use Tele Button to
magnify.

5. To navigate the magnified picture, press OK
Button to enter navigation mode (The inner
Magnification Indicator turns orange). Use
Direction Buttons to navigate the magnified
picture. Press OK Button again to exit navigation
mode.

24
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Picture Playback Mode Menu

Operation

Display Screen

1. In Picture Playback Mode, press Menu/OK
Button to enter Picture Playback menu screen.

2. Use Up/Down Buttons to select three options,
Delete, Lock, and Slideshow.

Delete

Lock
Slideshow

T3 OK =3 Exit

Delete Picture

Operation

Display Screen

1. Use Down Buttons to select the Delete option.

Lock
Slideshow

3 0K =3 Exit

2. Press Menu/OK Button to go to the Delete menu.
3. Use Right/Left Buttons to select the picture.

4. Use Up Button to delete all pictures or Down
Button to delete single picture. Or Press
RECORD/PLAY Button to exit.

5. Before a picture is deleted, a confirmation screen
will appear; choosing “Yes” will execute the
operation, “No” will cancel the operation.

6. Press Menu/OK Button to validate the setting.

No

~One - Exit

‘. Note
-_).

» If a memory card is inserted, you can delete only those pictures stored on the card.

* Pictures on a written-protected memory card cannot be deleted.

» The delete function will only erase unlocked pictures. Locked pictures must be unlocked

before being deleted.

25
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Lock Pictures

Single or all pictures can be locked. This function can prevent the pictures from being deleted

accidentally.

Operation

Display Screen

1. Use Up/Down Buttons to select the Lock option.

Delete

Slideshow

A OK =3 Exit

2. Press Menu/OK Button to go to the Lock menu.
3. Use Right/Left Buttons to select the picture.

4. Use Up Button to lock/unlock all pictures or
Down Button to lock/unlock single picture.

5. Press RECORD/PLAY Button to exit.

Make Slide Show

This function automatically repeats all pictures in order.

Operation

Display Screen

1. Use Up/Down Buttons to select the Slideshow
option.

2. Press Menu/OK Button to start the slide show;
press it again to stop and return to the previous
page.

Delata

Lock

3 0K =32 Exit
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Section 5

Setting Your Camcorder

Setting Menu

Setting Option

Display Screen

1. In Record Mode, press Menu/OK Button to enter
record menu screen.

2. Use Right/Left Buttons to select Setting.

3. The Setting Submenu contains 7 options for
configuring your camcorder set up. They are

Sound (operation sound),Information, Time
Setting,Format, TV,Language,and Default Setting.

" O g
Sound

Information ..
Time Setting

Format

A OK =3 Exit

Sound

Enable or disable KeyPad tone and operation sound.

Operation

Display Screen

1. In setting Submenu, press Down Button to go to
the Sound menu.

2. Use Right/Left Buttons to choose On or Off.
3. Press Menu/OK Button to validate the setting.

® O & O

Sound Onap
Information . On
Time Setting

Format

A OK =3 Exit

Information

To change Information setting by either hot key (Up Button) or Option Setting:

On: Show the indicator(s) on the LCD screen.

Off: Do not show the indicator(s) on the LCD screen.

1. In setting Submenu, press Down Button to go to
the Information menu.

2. Use Right/Left Buttons to choose On or Off.
3. Press Menu/OK Button to validate the setting.

3 OK =3 Exit

27
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Time Setting

Operation Display Screen

1. In setting Submenu, press Down Button to go to
the Time Setting menu.

Information, .-

Format

30K == Exit

2. Move between Date and Time by using Up/Down
Buttons. Adjust date and time by using Left/Right

Time Setting
Buttons. Yoar 2008 @
3. Press OK Button to validate the setting. Or Press Month 01

RECORD/PLAY button to leave Time Setting Day 01

. Hour 12 AM
without any change. Minute 92

3 OK == Exit

Format
Yes: Format the built-in memory (When there is no SD Card in the camcorder) / SD Card (When there
is an SD Card in the camcorder).

No: Do not format the built-in memory (When there is no SD Card in the camcorder) / SD Card (When
there is an SD Card in the camcorder).

Operation Display Screen

1. In setting Submenu, press Down Button to go to
the Format menu. - 0 g

2. Press Menu/OK Button to go to the Format

i i Sound
confirmation screen.

Infarr_maﬂ'a_n .
Time Setting
Format

I3 0K =3 Exit

3. Use Right/Left Buttons to choose Yes or No.

4. Choosing “Yes” will execute the operation, “No”
will cancel the operation.

5. Press Menu/OK Button to validate the setting.

_j’. Note
All the data will be erased if the SD card is formatted. Make sure all the data are backed-up to
PC before formatting SD card.

28
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TV

Ensure that the appropriate TV standard of your area is selected — either NTSC or PAL.

Wrong TV system setting may cause image flicker.

NTSC standard: USA, Canada, Japan, South Korea and Taiwan etc.
PAL standard: UK, Europe, China, Australia, Singapore and Hong Kong etc.

Operation

Display Screen

1. In setting Submenu, press Down Button to go to
the TV menu.

2. Use Right/Left Buttons to choose NTSC(60Hz) or
PAL(50Hz).

3. Press Menu/OK Button to validate the setting.

”® o & O

TV NTSC(60Hz)a»

Language . . English
Default Setting

3 OK =3 Exit

Language

Use this option to select the language of user interface which you want.

Operation

Display Screen

1. In setting Submenu, press Down Button to go to
the Language menu.

2. Use Right/Left Buttons to choose the language
options.

3. Press Menu/OK Button to validate the setting.

2 A & O
v NTSC(60H2)

Defaiult Setting

EAE OK =3 Exit
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Default Setting

To restore the default factory setting, select this option.

Operation

Display Screen

the Default Setting menu.

Setting confirmation screen.

1. In setting Submenu, press Down Button to go to

2. Press Menu/OK Button to go to the Default

» B & O
V. NTSC(60Hz)

Language .. English

=3 OK = Exit

will cancel the operation.

3. Use Right/Left Buttons to choose Yes or No.

4. Choosing “Yes” will execute the operation, “No

5. Press Menu/OK Button to validate the setting.

Default Setting

No

The following table indicates the Camcorder’s default setting

Setting Default Factory Setting
Resolution HD (1080p) for Movie
Standard for Picture
Light Off
Self-timer Off
Scene Auto
Exposure OEV
WB (White Balance) Auto
Sound On
Information On
TV Depends on shipping area
Language Depends on shipping area
Volume Level 12
Macro Normal
Stabilization Off
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Section 6
Viewing Pictures and Moviesona TV

Connecting to a High-Definition 16:9 (Wide) TV

1. Connect one end of the HDMI cable to your Camcorder’s HDMI Out port.
2. Connect the other end of the cable to a television.
3. Set video input source of a TV to “HDMI” option.

4. The steps for viewing stored pictures and movie on a TV are exactly the same as for viewing them
on the LCD monitor.

\‘“\’—'
Tz,
Note

The camcorder can not run movie recording and picture taking when it is connected to an
HDTV. The LCD Panel does not display when the camcorder is connected to an HDTV.

Connecting to a non-high-definition 4:3 TV

1. Connect one end of the AV cable to your Camcorder’s AV In port.
2. Connect the other end of the cable to a television.

3. The steps for viewing stored pictures and movie on a TV are exactly the same as for viewing them
on the LCD monitor.

Note

The LCD Panel does not display when the camcorder is connected to a TV.

EN
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Section 7
Viewing Pictures and Movies on PC

Installing Bundled Software

The CD-ROM supplied with this Camcorder contains 2 pieces of software.

* ArcSoft Medialmpression is a user-friendly application that helps you managing your media,
burning your video into DVD, and uploading your videos to YouTube easily.

» Adobe Reader is a popular program that you need to have installed to read the User’s Manual.
Many computer users will find they already have this software installed on their computer.

To install the bundled software:
1. Insert the CD-ROM into your computer’s CD-ROM drive. The autorun screen appears.

2. Click Install Application Software. Follow the on-screen instructions to complete the installation.

TOSHIBA

CAMILEO P30

Instell Application Software

0O ArcSolt Meciabmpression

| exit |

Note

The detailed information can be found in online help of all the bundled software.

Transferring Data to a Computer

You can transfer pictures or movies stored on your Camcorder to a computer and send them in emails
to friends or post them on websites.

To do this you should:

1. Connect the computer and Camcorder with the supplied mini USB 2.0 cable. The LED will light up
and blink.

2. After the LED stops blinking, movies and picture(s) can be found on your computer at “My
Computer\Removable Disk\DCIM\100MEDIA”.

3. Under this folder, you can view, delete, move, or copy any movie/picture you want.

4. Use the bundled ArcSoft application software to edit the movies or pictures.
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Section 8
Burning the Recorded Clip into DVD

Bundled software CD contains ArcSoft Medialmpression features burning the movie clip into DVD. You
can share this DVD movie with family and friends by using regular DVD player.

To create a DVD:

1. Install ArcSoft Medialmpression (Refer to Section 7).

2. Click Windows [Start] - [(All) Programs] = [ArcSoft Medialmpression].
3. ArcSoft Medialmpression main screen will appear on your desktop.

4. Click [Make Movie].

ArcSoft Medialmpression® Exfras _ = X

Welcome to ArcSoft MediaImpression.

Choose a media type or action from the options below.

il i
Pictures

Yideo

B
[ allMedia

Import

E Make Movie

’g WebCam

— =,

B easy walcome to ArcSoft Medialmpression. You can
conveniently manage your media content and

— create projects here, Click a button on the left

%% Easy Print to get started.

|:| Skip this page when you launch the program
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5. The operation screen will appear:
+ Select the folder that contains the video files you want to burn.
» Select the file(s).
+ Click button to add the files into slide.
* Click [Burn to Disc].

ArcSoh Medialmpression® Eire: _ M %
Makse Movie '
Cuickly and sasly produce professonal-looking moves foaburing your ol phobo and viced fles.

ErTTT— T - T T —

i_ __Ifm !_m B O:\Dosuments and Settings JaviDeskopd - 1 flels)

| €+ Go Lo Start Page |

L i

| L) My Documents 11 12
- My Compaker
+ B 3% Floopy (A2
g WINTESE (L)
= dge WD (D)
= ) Documenits and Settings
¥ Al sers
=0 ey
I3 Deshtop
+ Uy Favorkes
+ 3 My Doscumnsnts. q

-1
1y Steet Mers S gL

Lilie arhes
B Wy Favortes

= My Computer
# [%e wipdD:)

ﬂ.-e-sd':- 2.06M5 1 M),

6. Click [Start] to start DVD burning.

Burn to Disc »
WD DD ‘-.__
Desvice:
CVD meny skyle Enter title
| PlayFul | [ Unitled |

Enter date

| Friday May 09 2008 |

archive sour source media files

Stark
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Section 9
Uploading Video Files to YouTube

Bundled software CD contains ArcSoft Medialmpression features uploading the recorded videos to
YouTube. It will help you to share them with your family and friends on YouTube website.

To upload video files to YouTube:

1. Install ArcSoft Medialmpression (Refer to Section 7).

2. Click Windows [Start] = [(All) Programs] - [ArcSoft Medialmpression].
3. ArcSoft Medialmpression main screen will appear on your desktop.

4. Click [Video] Option.

ArcSoft Medialmpression® Extras _ M X

Welcome to ArcSoft Medialmpression.

Choose a media type or action from the options below.

==l pj
= Pictures

ﬁ.' Yideo
[ allMedia
% Import
E Make Movie
’g WebCam
QT Easy Fixt
L ¥ Welcome to ArcSoft Medialmpression. You can
conveniently manage your media content and
— create projects here. Click a button on the left
L%/ Easy Print to get started.

I:‘ Skip this page when you launch the program
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5. Select the video file you want to upload and click [Upload to YouTube] option at the bottom menu.

Arrinft Medialmpression® e = R
= f
ledia Browser | € GuluSlark Page |

Pleage select media files and select an action.

13 255_4_25_MIZ0LD
) LD AL Merson
L Ak Pl cabug ©57
) A 2.5 O Eval
) AudioCpt _philps
B | Frud T etV 53
3 Bin
1) Chicorry_NT96120_San
1 o144
By bom

L 2000WIE
3 Ha&4-viden

.: ELIPIORG. avi LIPINAE .

Librarkes m —

W o B ¢ 2 G- e g
Ingunl Moshin Playmr  Midhse Pveim | | Uglinl b YemiTuken | | WebCam  Faey fechive Cpern ArcSoft  Open Wit Sehup

E.BGME 1 Hir(s] seterted | 7 5]

Rpady

6. If this is your first using of this function, please follow the instruction on YouTube Setting Panel.

-
YouTube Setting

Setup Guide for Uploading Files to YouTube:

Medialmpression needs vour authorization before it can upload files to vour YouTube
account, You only need ko sek this once For each YouTube account, (To upload Files ko a
different YouTube account, log onto that account and repeat these steps. )

Step1:
Flease log anto your YouTube account First,

Go Tu:(l_wtl:p:.ffwww.vnutube.cnmflnqiﬂ]

Step 2 :
Please click "Get suthorization™ and then click *allow® in the pop-up window to confirm.

Gek Autharization |

Step 3:
'hen finished, click "Save" and return bo the main page, Mow vou can upload videos to wour
YouTube account,

| Save
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7. Go to http://www.youtube.com/login, then log onto your YouTube account.

W YunTabe - Hroadeast Vonesell. - Mictom il Inbemet Explose:

EXP WHE WAy SEARL IND NED
Otx-Q HE®h Feefroemr @ -5 -0 JE

FEL ] hep twws yostabe comiiop - l‘i ¢
Google Gie o B O~ {F Bookoadew [Bi6blocksd T Check ~ 4 Sublink = o Send 0w J emnge
k‘n‘lemberLogln =

iLogin 1o aoceds pour ateounl

~
ouTuk® Usarnarme

ouTube Pasiwerd

|

Ereirdl Uspinamd | Eoroct Pakieerd

koo wilfl yeur GORGE: account

What Is YouTube?
IYouTube is the home Tor video online

= Wateh millions of videos

« Bhare favorites with frends and family

= Connmect with ather users who share your inerests
= Upload your videos to a worldwide ausence

|5tan up now te join the YouTube community.

Face The Candudales
AT oo Videps | Sedrch
Wi Aot Halji & Wil

(If you do not have YouTube account, sign up here first.)

8. After you log onto your YouTube account, Click [Get Authorization] button below.

-
YouTube Setting x

Setup Guide for Uploading Files to YouTube;

Medialmpression needs your authorization before it can upload Files ko wvour YouTube
account, You only need to set this once For each YouTube account, (To upload Files to a
different YouTube account, log onto that account and repeat these steps, )

Step1:
Flease log onto your YouTube account first,

Go To: htkp: ) feesee voutube, comflogin

Step 2 :
Please click "aet duthorization™ and then click, *allow” in the pop-up window ko confirm,

( ek Authorization |]

Step 3:

When finished, click "Save" and return to the main page. Mow vou can upload videos bo your
YouTube account,

| Save
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Then, Click [Allow] Button shown on YouTube website.

A YouTube - Breadcast Yourself, - Microsoft Internet Explorer

Ein Edt \ew Fioetes Inok Heb o

am B - | “‘I If, fa | ) seach e reones ) (- i [ Ere )
Ackeress: | () Petpweren. pouties cotuser_aps_mRhTges b AWENE_TEB_ el 7461 THSOR6000 964 1STOT TR 1583 e
Y Hi, ghicoreet]) | & 0 | Actoun | Histore® | Helo | Log Oyl | S#. €
Hroacca alf Homa Videos Channals Community
\ideaos v zeeigz Upload
Third-party Applications
Medialmpression wants your permission!
The P wousd like 110 upioad videos fo your oot

Hoyou want 1 Grand permissien, |ust elick the button bl
App Name: Medialmpresshon
Parmisskons Requested wile

o | g to iGooale Videos v 127 Ebea The Conitates

Your Account Melp & Info YouTube

Enirpifity [E YD Tooke, i btk Ieluts i)

Btz e, Derenioner 8513 Come iy Cuigeines. Teems of iize g

Aahverishg Petvarcy Polcy. -4
© 2008 YouTube, LAC
£] vore ® Intamrat
9. Click [Save] Button to upload the video.
i
YouTube Setting X

Setup Guide for Uploading Files to YouTube:

Medialmpression needs your authorization before it can upload files to your YouTube
account, You only need to sek this once For each YouTube account, {To upload files to a
different YouTube account, log onto that account and repeat these steps.)

Step 1:
Please log onto your YouTube account First.,

Go To: http:ffweww, voutube. comflogin

Step 2:
Please dick "Get Autharization™” and then click “allow” in the pop-up window to confirm.

Get Authorization

Step 3:
wehen finished, click "Save" and return to the main page. Mow vou can upload videos to your

YouTube account,
S‘BL]

YouTube b

Lploading the file "Wideo3wrmw”,

N >

Cancel
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Specification

Image Sensor
Operation Modes
Lens

Focus Range
Zoom

Shutter
LCD monitor
Storage Media

Image Resolution

Movie Resolution

White Balance
Exposure
Self-timer
Light

File Format

Image play
PC Interface
TV out
Battery
Dimension
Weight

Section 10
Specifications

5 Mega Pixel CMOS Sensor

Movie Record, Picture Record

f=6.8 ~ 34mm; F3.5 ~3.7

Macro: 1 ~ 80cm

Normal: 10cm ~ infinite

HD(1080p): 1X~10X (5X Optical + 2X Digital).
Other video resolution: 1X~20X (5X Optical + 4X Digital)
Electronic

2.5"LCD

Built-in 128MB Memory (partial memory is used for Firmware code);
SD Card Slot support

High 3200x2400 (8M Pixels)

Std 2592x1944 (5M Pixels)

Low 2048x1536 (3M Pixels)

HD(1080p) 1440X1080(30fps)

HD(720p) 1280X720(30fps)

WVGA 848X480(60fps)

VGA 640X480(30fps)

QVGA 320X240(30fps)

Auto/Manual (Daylight, Fluorescent, Tungsten)
Auto/Manual

10 second delay

On/Off

Picture: JPG

Movie: MOV

Single Image/Slideshow

Mini USB 2.0 Port

NTSC/PAL Selectable, HDMI

Lithium-ion Rechargeable Battery

104(H) * 82(W) * 38(D) mm

119g (without battery)
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Section 11
Troubleshooting

Troubleshooting

1. If the LCD image is not clear when shooting, how can the focus be adjusted?

Taking photos and the object is within 80 cm, use Macro Mode which is the Submenu of Effect Mode.

2. The light is not working.

The battery power is low.

3. The files on the memory card do not display smoothly when the LCD shows the “!” marking.

The “I” means the SD card is low speed or having wrong content inside. The way to solve this condition
is to format SD card by camcorder instead of PC. (Please refer to the detail Format instruction in Section
5).

4. Why do some of my indoor pictures look blurry and dark?

Camcorder extends pictures exposure time under low light/ indoor condition. Keep camcorder (and
photographed subject) steady for several seconds when taking pictures. Shutter will sound when picture
has been taken.

5. How do | charge battery?

Computer will not charge battery when connected. You must use ONLY the supplied AC charger.
Camcorder must be turned OFF; blinking light confirms charging, but light is constant when charging has
been completed.
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Section 12
Other Information

TOSHIBA Support

Need help?

For the latest driver updates, user's manuals & FAQ's please have a look at the
TOSHIBA options & services support page:
computers.toshiba.eu/options-support

Please see computers.toshiba.eu/options-warranty
for the TOSHIBA hotline numbers.

Operating Environment Conditions

Operating temperature: 5 to 35° C
Operating humidity: 20 to 80 %

(no condensation allowed)

Regulatory Information

CE compliance

1r

AA46

This product is CE marked in accordance with the requirements of the applicable EU Directives.
Responsible for CE marking is Toshiba Europe GmbH, Hammfelddamm 8, 41460 Neuss, Germany. A
copy of the official Declaration of Conformity can be obtained from following website:
http://epps.toshiba-teg.com.

Working Environment

The Electromagnetic Compliance (EMC) of this product has been verified typically for this product
category for a so called Residential, Commercial & Light Industry Environment. Any other working
environment has not been verified by Toshiba and the use of this product in these working
environments is maybe restricted or cannot be recommended. Possible consequences of the use of
this product in non verified working environments can be: Disturbances of other products or of this
product in the nearby surrounding area with temporarily malfunction or data loss/corruption as result.
Example of non verified working environments and related advices:

Industrial environment (e.g. environments where a mains voltage of 380V three-phase is being used
mainly): Danger of disturbances of this product due to possible strong electromagnetic fields especially
near to big machinery or power units.
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Medical environment: The compliance to the Medical Product Directive has not been verified by
Toshiba, therefore this product cannot be used as a medical product without further verification. The
use in usual office environments e.g. in hospitals should be no problem if there is no restriction by the
responsible administration.

This product is not certified as a medical product according to the Medical Product Directive 93/42 EEC.

Automotive environment: Please search the owner instructions of the related vehicle for advices
regarding the use of this product (category).

Aviation environment: Please follow the instructions of the flight personnel regarding restrictions of use.

Additional environments not related to EMC

Outdoor use: As a typical home/office equipment this product has no special resistance against ingress
of moisture and is not strong shock proofed.

Explosive atmosphere: The use of this product in such special working environment (Ex) is not allowed.

Following information is only valid for EU-member states:
Disposal of products

The crossed out wheeled dust bin symbol indicates that products must be
collected and disposed of separately from household waste. Integrated batteries
and accumulators can be disposed of with the product. They will be separated at
the recycling centres.

The black bar indicates that the product was placed on the market after August _
13, 2005.

By participating in separate collection of products and batteries, you will help to assure the proper
disposal of products and batteries and thus help to prevent potential negative consequences for the
environment and human health.

For more detailed information about the collection and recycling programmes available in your country,
please visit our website (http://eu.computers.toshiba-europe.com) or contact your local city office or
the shop where you purchased the product.

Disposal of batteries and/or accumulators

The crossed out wheeled dust bin symbol indicates that batteries and/or accumulators must be
collected and disposed of separately from household waste.

If the battery or accumulator contains more than the specified values of lead (Pb),
mercury (Hg), and/or cadmium (Cd) defined in the Battery Directive (2006/66/EC),
then the chemical symbols for lead (Pb), mercury (Hg) and/or cadmium (Cd) will
appear below the crossed out wheeled dust bin symbol.

By participating in separate collection of batteries, you will help to assure the proper
disposal of products and batteries and thus help to prevent potential negative
consequences for the environment and human health.

Pb,Hg,Cd

For more detailed information about the collection and recycling programmes available in your country,
please visit our website (http://eu.computers.toshiba-europe.com) or contact your local city office or
the shop where you purchased the product.
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Additional Information

© 2008 TOSHIBA Europe GmbH. All rights reserved.

TOSHIBA reserves the right to make technical changes. TOSHIBA assumes no liability for damages

incurred directly or indirectly from errors, omissions or discrepancies between this product and the
documentation.
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0970A8374L-A02F

I o S H I BA For further options & services see:

Leading Innovation >>> computers.toshiba-europe.com
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